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This Issue: 

     Allow me to reiterate Jeremy's appreciation expressed to Mini-PDI 

volunteers.  An event of this magnitude requires many people to help well 

in advance and the day of the event.  Thank you for all that you did to 

make our event successful.  Special thanks to Jeremy for stepping in 

during my absence with very little notice. 

     Each year we learn from the previous year, so please be sure your VP 

has received your feedback.  We have enough feedback to complete our 

lessons learned documentation and welcome additional input.  It's your 

chapter, this is one of the ways to make it great. 

     Many of us were fortunate enough to participate in both our chapter 

mini-PDI and our National PDI in Denver.  If your organization has a 

policy that you cannot attend both, please contact our professional 

development chair Maurice "Mo" Ottinger.  We would like to identify 

opportunities for the chapter to make both available to our members.  

     Our communications committee would appreciate pictures from 

national for our Facebook page and our Newsletter.  Look for an article in 

next month's newsletter about National PDI written by members who 

attended.  
 
Website: www.asmconline.org 
Twitter: @asmctweets   
Facebook: www.facebook/pages/American-Society-of-Military-Comptrollers 

FROM THE CHAPTER PRESIDENT 

Chapter President  

Angela Ruter 

http://www.asmconline.org
http://www.facebook/pages/American-Society-of-Military-Comptrollers
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CHAPTER   LUNCHEON 

 
May Luncheon 

Guest Speaker:  Mr. Don Kendrick 

mentoring 
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CHAPTER   LUNCHEON 

 
May Luncheon 

Guest Speaker:  Mr. Don Kendrick 

mentoring 
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CHAPTER  NEWS 

Volunteers needed! 

 
The 2018 Vectren Dayton Air Show is on 23/24 June and the Aviation Chapter 

needs volunteers to help with this event. Volunteers are needed on Saturday after-

noon and Sunday.   

 

If you are willing and able to volunteer, send Brenda Clinton an email with the  

information below to brenda.clinton@us.af.mil as soon as possible.   

  

NAME: 

ORGANIZATION: 

CELL PHONE NUMBER: 

DATE:  (Sat, 23 June 2018 or Sun, 24 June 2018) 

SHIFT:  (1st Shift, 700-1200 or 2nd Shift 1200-1700) 

JOB:  (Cashier, Float/Relief Cashier, Back-up Shift) T-SHIRT SIZE:  (Quantities 

are limited.  If you already have an ASMC T-Shirt from previous functions, please 

use it and do not request new) 

 

Note:  Family members are welcome to volunteer. However, due to the nature of 

the business, the preference is over 18 with cash handling experience.   
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CHAPTER  MEMBER NEWS 

 
 

 

 

Congratulations 

To 

 

Ms. JoAnne Wills  

Completed a  

Master of  

acquisition administration 
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TREASURERS’ REPORT/CHAPTER CALENDAR 

TREASURER’S REPORT 

April 2018 

Treasurers 

Rebecca Workman 

Dawn O’Connell 

Note:  
The Fidelity ending balances as of 30 April 2018. The Fidelity account balances are investments and fluc-

tuate with the market.  This causes unrealized gains and losses, which are captured in the Income. 

Aviation Chapter Calendar 

Jun 21 ASMC Luncheon—Col David Peeler, Holiday Inn Fairborn 

Jun 23-24 Vectren Dayton Air Show—Dayton Int’l Airport 

SAVE THE DATE—27 JULY 2018 
ASMC Golf  Tournament 

Look for further updates on the 
Aviation Chapter website and from 

your VPs 
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EXECUTIVE BOARD MEETING MINUTES 

ASMC – Aviation Chapter 

Executive Board Meeting Agenda 

15 May 2018 

1300 – 1400  

Call to Order - President:  Angela Ruter @ 1303 

Attendance/Reports 

Secretary: JoAnne Wills – requested from Jeremy for the dates and times to schedule the Meet-Me-

Numbers for the board meetings 

Committee Chairs: 

Augsburg Scholarship: JoAnne Wills – Letters were sent out to the High School winners for 

the scholarship. Need to know which luncheon we would want the winners to be presented to the 

memberships. The decision was to present them at the June board meeting. A suggestion was 

made that maybe the presentation of the scholarship could be done at the high school scholarship 

award ceremony. 

Communications: Tamie Bertke is retiring and we need someone to take over the newsletter. 

Community Activities: Darrell Allen II, Markina McKnight  

Helping Hands Drive: 20 May – 1 Jun – looking for donations and need help with col-

lecting the donations at AFIT, AFRL, and other organizations. An email will be sent 

out to the membership with the flyers. 

Darrell inquired on the Five Star status for the chapter and concerning the hours that 

were sent into Chapter competition. Angela said that she would touch base with JR 

concerning the hours. 

Professional Development: Maurice “Mo” Ottinger  

National PDI – complying a list of who will be attending and the Angela will be send-

ing an email to VIP on the list of who will be attending the conference  

Programs: April Kettlewell, Tammy Pendergast,  

May 17 – Mr. Don Kendrick - ”Yes, The Air Force Has a Mentor Program” 

June 21 – Col. David Peeler – Reflection on his career and leadership 

There was some issues brought up concerning the food in March which April did       

address with the hotel 

The only beverages that are being provided is coffee and water, which is included in the 

price of the ticket, if more than water is wanted, the price will increase. April is 

checking to see how much it will cost for May to include more than water.  
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EXECUTIVE BOARD MEETING MINUTES 

Chapter is breaking even with the luncheon and we have month by month contract with 

the hotel. April only signs the contract month prior to the luncheon. April stated that 

she will look at more places to hold the luncheon but to understand that the Holiday 

was lower place to hold the luncheon. The Club want too much for the luncheon 

which would increase the tickets to $18.00. The board is knows that we have lost 

people due to the increase luncheon price from $12 to $15. Suggestion were made to 

possible looking at doing cocktail meetings and maybe just having meetings without 

food included and do actual luncheon on a quarterly basis to include lunch. Base on 

Chapter Competition we are required to 9 – 10 meeting with some speakers. More 

research is needed to come up with a better solution concerning the luncheons and 

increasing the attendance. 

Ways & Mean: Brenda 

Working on the Dayton Air Show – need 15 more volunteers 

Angela is sending an email to the VIPs to send out to memberships for volunteers 

T-Shirts – where can they get the shirts to be given to the volunteers – Angela is 

looking into this. 

General Business:  

OLD: 

Budget Vote  

Administration changes 

Health & Wellness 

Angela is looking into this with Fernando and have a meeting with 

Jeremy concerning this. 

National PDI Nomination selected 

Markina McKnight has been chosen as the Aviation Chapter sponsor for Na-

tional PDI 

Mini-PDI 

Hot wash will be scheduled 

Megan didn’t get a lot of emails about participations and she still need 

feedback to be sent to her. 

Megan will be scheduling it once she receives more feedback 

NEW: 

July 2018 – June 2017 Board 

Currently board members who wants to stay or leave, please send an email to     

Angela and Jeremy  
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EXECUTIVE BOARD MEETING MINUTES 

Golf Outing  

Cheryl had sent an email about the golf outing and it was only a joint golf 

outing  

Angela/Jeremy will be sending out an email about possibility having an 

ASMC golf outing and see if any of the members would be interested in 

doing one. 

Professional Event – June (TBA) 

Having a mock interviews to help individuals on how to be prepare on doing 

interviews for GS-13 to GS-14. 

There are individuals who are line up to do the mock interviews. 

It will be the last Thursday of June (28 June). 

Next Board meeting currently scheduled for the below:  

Date:  14 June 18 

Time: 1300 - 1400 

Meet-Me-Number: 937-257-8001 
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FM ARTICLE 

FERS Facts 24 
 

Food for thought (Editorial):  Are you prepar ing for  retirement?  From the time we are born we 
have always prepared for the next step in life.   We learned to roll over, then scoot, crawl, walk and run.  
Each new skill allowed us to expand our world.  Most of us spent two decades or more in school preparing 
for our careers.  Once employed we constantly have looked for ways to improve our skills, learn more so 
we can advance and be more productive.   Our aim is to always move forward and upward; we have been 
doing that since birth.  It’s natural; we are comfortable doing it year after year.  Then rumors of retire-
ment!  What is this?  It does not fit the pattern?  I think that is why most of us view retirement as such a 
scary thing and many of us choose not to think about it.   We are too busy doing what we have trained our-
selves to do…work.  As Americans we like to work and we are good at it having some of the highest 
worker productivity rates in the world.  We are not so good about preparing to retire.  Most Americans 
have very little savings and even less put away for retirement. Nor do they have any real idea how they 
will support themselves once their working years are over. 

Nothing we typically do prepares us to retire.  Then something interesting happens, we start to wear out.  
Things begin to hurt, we cannot do everything we used to do, we begin to forget things maybe we have a 
health scare or watch family or a friend deal with a serious health issue and suddenly retirement does not 
seem that odd of a concept.  Just as we prepared to have a career we need to prepare ourselves for life after 
work.  

Last spring we began this series of articles addressing the specifics of retirement (especially for those un-
der FERS).  Retirement is coming and we all need to prepare ourselves. No one else will do this for you.  
FERS Facts #11 and #19 address specific things that each of us can do to prepare regardless of where we 
are in our careers.  If you need a copy of those articles I can forward them to you. Set some time aside to 
review your situation at least yearly, review it more often as you get closer to retirement age.  Sooner is 
better as it takes time to prepare.  If you are like me I forget the details unless I review them regularly.   

Did you Know?  When you retire FERS pension (annuity), Social Secur ity (SSI) benefits and TSP 
(unless you have a Roth account) are all taxable as ordinary income.  Did you also know you must fill out 
a W-4 for each of these with OPM for tax withholding and with your state of residence (if the state you 
live in taxes SSI)?  OPM will not automatically do this, you must ask to have taxes withheld for each. You 
have 3 choices here.  You can set up withholding, make quarterly estimated payments to the Feds and 
State (that is also up to you to set up) or you can ignore the tax bill until due.  Failure to pre-pay at least 
90% of your tax bill will result in penalties (10% of the difference) and fees being added to the taxes you 
owe come April.  Ouch!  For your information as of today 13 states tax SSI benefits: Colorado, Connecti-
cut, Kansas, Minnesota, Missouri, Montana, Nebraska, New Mexico, North Dakota, Rhode Island, Utah, 
Vermont and West Virginia (not quite heaven).   

Till the next time,  

Richard 

Richard.strode@us.af.mil 
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COMPUTER TIPS and TRICKS by GEORGE DIEHL 

More Computer Tips to Make Daily Computer Usage Easier!   
 

Storage Sense in Windows 10 

Windows 10 includes a feature called Storage Sense. This feature assists you with freeing up wasted memory on 

your hard drive. Most of the wasted space includes files in your Recycle Bin, temporary system files, downloaded 

files that you only used one time, etc. By default, Storage Sense is disabled. To enable Storage Sense, open your 

Start Menu and search for “Storage” and the first result should be Storage within your system settings, click on it. 

From here, you will be in the Storage system settings where you can enable Storage Sense as well as change some 

of its settings. For a more detailed guide on how to do this, click here <https://www.windowscentral.com/how-use-

storage-sense-free-space-automatically-windows-10-fall-creators-update> .  
 

Note: At this time your work organization may not yet have this feature available but you should have access to it on your per-

sonal computer.  
 

The Office Clipboard:  

You can think of the clipboard, whether it is the Windows Clipboard or Office Clipboard (Word, Excel, Power-

Point, etc.), as the memory used when you do a copy and paste of something.   

 

The Windows Clipboard only holds one item at a time which is why you normally can only copy and paste one item 

at a time.   
 

The Office Clipboard is capable of storing up to 24 items at a time. This means that you could copy up to 24 items 

at once and then paste them where you need them instead of doing a copy then paste for each item which is very 

tedious if you are doing a lot of toggling between two Office files (email, word document, slide show, spreadsheet, 

etc.). You do not need to do anything special to activate it. The trick is knowing where it is hiding:   
 

Step 1 – In any Office program go to the Home Tab (Message Tab in an Outlook message window).  

Step 2 – Look at the “Paste” button on the very top left of the Home Tab ribbon. It is a clipboard icon. Be-

low that button you will see the word “Clipboard” with a tiny arrow to the right of it.  

Step 3 – Click on the arrow.  
 

This will open the “Clipboard Task Pane” where you will see the items that are currently in the clipboard. If you 

click on any of these items it will paste that item wherever your cursor is. There is also a “Paste All” button at the 

top of the task pane.   
 

The Office Clipboard runs in the background as long as you have an Office program running. If you have been cop-

ying a lot of things you’re clipboard can get pretty full. This is why you’ve probably seen a message stating that 

“there is a lot of data in the clipboard, do you want to save it for other programs?” when you close the only/last Of-

fice program that you have open.   

 

Sparklines and RANDBETWEEN() in Excel 
 

A useful function in Excel is the RANDBETWEEN function. It will generate a random value between a min and 

max that you specify. This is a useful tool when you just need some random numbers. Example: 

“=RANDBETWEEN(1,100)” will give you a random value between 1 and 100. 
 

Note: The random value will change to another random value every time the sheet is recalculated (basically anytime you 

change a cell). 
 

We will use the RAND function to demonstrate a lesser known feature in Excel called Sparklines. Sparklines allows 

you to create a line, column, or win/loss chart inside of a cell.  
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COMPUTER TIPS and TRICKS by George Diehl 

Example: 
 

 Open an Excel spreadsheet and put “=RANDBETWEEN(1,100)” in cells A1:A10.  

 Select cells A1:A10. 

 Click on the “Insert” tab at the top.  

 Towards the middle of the ribbon you should see a “Sparklines” section showing 3 buttons (Line, Column, and Win/Loss). 

 Click on the type of chart you would like to see.  

 This will bring up a small “Create Sparklines” window. The Data Range should already be set to A1:A10.  

 In Location Range just put/select B1 and press “OK”. 

 Now you should see a small chart in cell B1.  

 

Since we used the RANDBETWEEN function for the values, every time you change a cell all the values will recal-

culate and you’ll see the chart in B1 change.  Not sure when you would need this tool but it is certainly a neat fea-

ture of Excel.  
 

Use Bluetooth Securely 
 

Bluetooth is a feature which some users rarely touch and others use almost all the time. While I will be focused spe-

cifically on smartphones and computers in the following tip, keep in mind that Bluetooth is used in countless devic-

es (e.g., smartwatches, Fitbits, smart TVs and Blu-Ray players). Regardless of your level of usage, you should en-

sure you are doing so securely. Not everyone realizes that your smartphone or computer can easily be identified 

even if you have it set to not be discoverable. In short, while Bluetooth is on, your device is continually looking to 

receive a signal. While Bluetooth will usually have a range less than 30 ft., attackers can easily sit in the open in a 

public area and actively search for Bluetooth enabled devices.  
 

There are three simple steps to ensure your Bluetooth does not become a vulnerability. One, turn off Bluetooth when 

you are not using it. This may be one of the easiest security measures you can take, especially if you are not a regu-

lar user of the technology. Two, do not use the default PINs for pairing devices. If an attacker sees your device, the 

first thing they will likely do is try connecting using the common default PINs. Three, ensure you keep your device 

updated. Last year the BlueBorne vulnerabilities were discovered. These vulnerabilities basically enabled attackers 

to access, and even take control of, your device without you noticing. Additionally, once one device is infected, it 

could be set to infect any other devices it comes within range. The BlueBorne vulnerabilities were quickly patched 

by Google, Apple, and Microsoft. However, the patches do not help if you do not download and install them on a 

regular basis.  
 

Cell Phone, Internet, and TV Service Shopping Tool 
 

Shopping for a new cell phone, wireless provider, internet service provider, or TV provider can be a challenging 

process. Trying to keep track of which company provides service to your area and whether or not the hardware you 

have is compatible if you are looking to switch from one to another. This is complicated even further with cell 

phones if you decide to purchase an unlocked cell phone (i.e., purchase a cell phone through a manufacturer or dis-

tributer instead of through the cell service provider). Additionally, any given service provider will only provide in-

formation on their services. A handy tool I have used to help compare multiple service providers is a website called 

Whistleout (https://www.whistleout.com/). This site allows you to do some comparison shopping between many 

service providers at once. Using cell service providers as an example, you can not only compare the top four cell 

carriers (Verizon, ATT, Sprint, and T-Mobile) but you can also compare their mobile virtual network operators (e.g., 

Cricket, Boost Mobile, Republic Wireless). This site additionally provides guides, tips, and tools to aid you in your 

shopping efforts.  
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ASMC NATIONAL PROGRAM NEWS 

Maintain your DoD FM & CDFM with Becker! 

 

Defense financial management professionals know how important it is to keep up with a constantly 
changing business world. ASMC is joining Becker Professional Education to bring you a new way of 
accessing the educational resources you need to help advance your career. Becker’s Continuing Profes-
sional Education (CPE) courses can provide the professional development you need and earn the CET 
credits required to maintain DoD FM Certification Program (DFMCP), CDFM, CPA, CGFM, CMA, 
CIA and other professional certifications. And for a limited time, Becker is offering ASMC members a 
20% discount for On Demand Subscription Courses! 

With Becker’s CPE courses, not only can you sharpen  your skills, you can deepen your 

understanding of issues that are of utmost importance to your profession. Becker can 

equip you with knowledge and insight you can apply in your work immediately. You’ll be 

in a position to make the right decisions at the right moments – in ways that may not on-

ly help advance your career opportunities but also add value to your organization. 

For more information go to the ASMC National website:  http://www.asmconline.org/ 
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American Society of Military Comptrollers  ∙  Aviation Chapter 

P.O. Box 33515  ∙  Wright-Patterson AFB, OH 45433 

President Ms. Angela Ruter 

President-Elect Mr. Jeremy Miller 

Secretary Ms. JoAnne Wills 

Treasurers Ms. Rebecca Workman; Ms. Dawn O’Connell 

Organizational Vice Presidents 
88th CPTS VP Ms. Ane Graham (Primary) 

 Ms. Shannon Noles (Alternate) 

AFAA VP Ms. Sheena Fast 

AFIT VP Ms. Janene Garza 

AFMC VP Ms. Terri Desch 

AFRL VP Ms. Kristen Wentworth 

AFLCMC VP Mr. David Ohs; Col David Peeler 

At Large VP Ms. Amy Williams 

Contractor VP Ms. Ellen Gill 

Committee Chairs 
Audit Mr. Khanh Ensign; Ms. Susan Duening 

Augsburg Scholarship Ms. JoAnne Wills 

Awards and Recognition Mr. Steve Swiderski 
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Communications Ms. Colleen Robinson 

     Advertising/Publicity Ms. Anita Kearns 

     Newsletter Editor Ms. Tamie Bertke 

     Photographer Ms. Elaine Norsworthy 

     Webmaster Mr. Jonathan Paden 

Community Activities Mr. Darrell Allen II; Ms. Markina McKnight 

Health & Wellness Mr. Fernando Mason 

Membership Ms. Angela Brown; Ms. Cynthia Payne 

Professional Development Dr. Maurice “Mo” Ottinger 

Programs Ms. Tammy Pendergast; Ms. April Kettlewell 

     Tickets Ms. Jeannette Dennis 

Ways & Means Ms. Cheryl Deckard 
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